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Introduction m

Introduction

My love affair with the Internet began back in 1992 when, with my trusty Mac and a very
slow modem, I managed to send my first e-mail message from my house in Los Angeles,
all the way to a friend across the world in Thailand. And when I received a message back
from him in a matter of minutes, you can’'t even imagine my exhilaration!

Four years later, to my astonishment, I'm still excited. In this book I'll try my best to
share with you some of my enthusiasm by showing you how to :

Navigate the World Wide Web

Send electronic mail

Find the information you're looking for

Locate and download software

Meet and communicate with people from around the world
Use the Internet in your teaching

Create and promote your very own Web page

Even find a job

And if that’s not enough, I'll also share with you several hundred of my favorite
ESL/EFL Web sites, gathered from my voluminous journeys (and several hundred
hours) across the World Wide Web.

Remember: Things Change

I've tried my best to keep everything as up-to-date and accurate as possible, but the
Internet is a dynamic entity where things are continuously evolving—addresses
change, sites close down, technology becomes outdated, and products come and go.
If you have any problems, spot any errors, or just feel like saying hello, please feel free
to e-mail me at:

sperling@eslcafe.com
In addition, I'll be keeping things current on my Update Page located at:
http://www.eslcafe.com/book/

You'll also find a bulletin board where you can give me instant feedback for future edi-
tions of this book. It’s located at:

http://www.eslcafe.com/book/wwwboard.html
I'd love to hear from you!

Dave Sperling
California State University, Northridge
March 10, 1997



ACkHOWIngmentS.----.o.---.......-....-o..--Viii

Introduction . . ¢ ¢ ¢ v v vttt e e e e e e e e e e e e s e e e X

Remember: ThingsChange . . . . . .. . . ... ..., ix

1 Welcometothelnternet! . . . . ¢ v v v v v v v v o o 0o o o oo onooa

The Internet: What'sinlt forMe? . . . . . . ¢ vt v o v o b o v o v v o v

.

A Brief History of theinternet . . . . . . . ... ... ..o
Internet 101: The BasiCs . . « v v ¢« v v v v v o o v e o v o o v o o o o s o oon
GettingConnected . . . . . . . . i i i i i it it e e e e e e e e
TypesofConnections . . . . . . . ¢ v v v v v v v v v o o oo o oo oo
APeekintothe Future . . . . . . ¢ i i i v v it o o o v v v v oo oo v v
TheWorldWide Web . . . . . . . i i i i it ittt et oo oo oo oo vn
WEDBIOWSEIS . & v ¢ v v v v v ot v e b e o ot o ot oo s o oo oo
TheWeb Address . . . . ¢ . v o v v i i vt o vt o v ot oo v o

SOME COOITIPS v v v v v vt v e et ot b st s oo oo s s s ees

.

.

Terms YOu Should Know . . . & & v v o v v o b e o o v o o o o o o

.

BeyondtheWeb . . . . . . . i i i i i i i i i i it it e st et e e

Helper Applicationsand Plug-ins . . . . . . « ¢« ¢ ¢« o v v v v v v o o
Kids Will Be Kids: A Lesson in Cybersafety

FurtherHelp . . . . v ¢ o i i i e i e e e e e o e o oo oo oo s

.
.
.
.
.
.
.
.
.
.
.
.
.
.
.
.
.

O O ® W 0 N N U & & W W PN = o

-l ok

.
.

°
)

—
e

2 Finding Resources and Information . . ...............
SearchEnginegs . . . . . . ¢ . ¢ i i i i i it e e e e e e e 1
Multiple Simultaneous SearchEngines . . . . ... .........13
Directories . . . « v v v v v v vt bt e e e e e e s e 15
LIbraries . . v v v v v i ittt e e et e e e st e e s e 16
White Pages: FindingPeople . ... ... ... .00t es... 18
FindingSoftware . . . . . . . i i it i ittt et oosesss 19
Language Learning Software . . . . . . . v v v v e e e e ... 20

MorePlacestoSearch . . . . . . ¢ v i v i i o b o b o v e e e e 22



Contents

3 CommunicatingontheNet . ...
Email . ...............

Using E-mail in the Classroom

Mailing Lists . . . .
Finding a List .
Student Lists .
Teacher Lists .

.

.

.

.

USENET Newsgroups . . .

Finding a Newsgroup
ESL/EFL-related Groups

Web Discussion Boards

.

.

LiveChat ..........
Internet Relay Chat (IRC)

Web Chat . . .
MOOs

Audio ... .....

e o e e o e e

Videoconferencing .
Netiquette . . . . .

4 Creating a Basic Web Page

.

Starting Up with HTML . .
Doing More with HTML . .

Text . . . ... ...

Heads

L

Paragraphs and Lines

Links

.

.

e+ e s s e e e e

Color and Background

Pictures
Common HTML Tags

HTML Editors to the Rescue

Onto the Net

D Y

« s e e

D

Promoting Your Web Page .

.

.

.

.

.

* e e e e

24
24
26
28
28
29
30
34
34
35
36
37
37
38
39
40
41
42

43
43
44
45
45
46
47
47
49
49
50
51
51



5 Dave’s Guide to the Best of the Web

Articles . . . .. ... ... ...

Associations . .. ...
Bilingual Education . .
Bookstores on the Web
Business English . . . .

.

.

.

-

.

.

.

D

Computer Assisted Language Learning (CALL) . . . .

Conferences . . . . ... ¢+ ...

» Dictionaries . ... .....

Disabilities . . ... ... ..

Distance Education ... ..

Drama ... ....¢¢...

Electronic ESL/EFL Publications

.

6 Encyclopedias . .. .. .....

English for Specific Purposes (ESP)

Games ... ......
Grammar .. ... ...
Lesson Plans and Material
» Libraries . .......
Linguistics . . ... ..
LinkS © ¢ ¢ o0 ¢ ¢ 0w s
Listening and Speaking
Literacy . ... ... ..
Literature . . . ... ..
7 Magazines .. .....
Meeting Other Teachers
Movies and Screenplays
Multicultural Issues . .
_/News and Newspapers .
OnlineHelp ......
Poetry .........

/ Pronunciation ... ..

.

.

.

.

.

.

.

.

.

.

.

-

I

Contents

...'.....52
- X
-7
s e e e s e e 56
O ) |
- 7 |
e -7 |
R 1 -
SRR - 1
Y 1]
e e e e ... 60
B ) |
s e e e e s e 61
I ]
e s e oo s ee. s 63
A - : )
R R - -
I 1 4
c e e e e .. 69
e [
e (1
R SR A |
S SR b']
R b
R & |
B £ ]
SR L |
R L |
c oo s s o s e I
s e v esveses 16
s o0 4w wiee oie BT
vosoup s wie ve BT



Contents

Proverbsand Quotations . .. ... .. ... ...t . .18
PublicSpeaking . . . . . v v vt i i v v vttt e et e s s s 18
PUBLIShETS « ¢ « ¢ 66 o 6 60 oo s 06 s os o sssosossssons 19
QUIZZES  © v ¢ ¢t v v s v v o o e o s s s o s oo oo s s sesesesess. 80
RESOUICES . & & ¢ v v v v v v v e ot s s v s s s oo s s s s v oeessas 81
SchoolDirectories . . . . . . ¢ ¢t v i i ittt ottt e e e ... 82
Schools — Individual ESLPrograms . . . . .. ... ... .........83
SoNGsaNAd MUSIC . . . v v v v v v vttt b e e e e e e 8T
Student InternetProjects . . . . . ... ...ttt e, . 88
TeacherTraiNing . . . & ¢ ¢« v v ¢t v 4 o 4 e o s o o s o o s oo oo oeaeass 89
Testingand Assessment . . . . . . . . vt v v v v v v e s e e eees..90
TheatreandDrama . . . . . . . ¢ i it i i i bt it ittt e e
L0 1 2 A |
TongueTwisters . . . . . . . . . i i i i i i it it ittt 92
US.Immigration . . . .. ... ...t eers..93
DT ' - T X |
VYocabulary,Idioms,andSlang . . . . . . . .. ...t .. 93

WHEHNG ¢ o6 65 v o 200 26 s 06 6 o6 s 658 noessnssnsesss 90

6 JobsontheNet .......¢000iiiieinneennnneneaes99
AffiCa & . . i s i e e e e e e e e e e e e e e e e e 99
- - e [
(6 1 T- T - T [ 0[]
(1 1 1 - PP 1) |
CzechRepublic . . . . . . i i i i i it ittt ittt eeessss. 101
EUrOPE . . . v i i i i i e e e e e st e e e e e e e e e e .. 101
General (ESL/EducationRelated) . . . ... ... ... .. ........ 102
HongKong . . . . . . . i i i i i i i ittt ittt it eeeess. 104
Indonesia . . . . .. .. i i i it i i i ettt e e e 104
Information . . . . . . . . . i it et i e e e e 105
T - | U U [ 11
106

K-120VeIZ@as . . « v ¢ v ¢« v v ¢ o ¢t s o v oo o v o oo eweeeesss 107

Job Interview

.
.
.
.
.
.
.
.
.
.
.
.
.
.
.
.
.
.
.
.
.
.
.
.
.
.
.
.
.
.
.
.



Contents 11

KOICa . . v v i i i e e e e e e e e e e e e e e e e e e e e 107

LatinAmerica .. ... ... ... 6 LS BN B E TR RS b o 108

MiddleEast . . . . . . . ¢t i i it e e e e e e e e e e e e e AR 108

Miscellaneous . . . . . . . ¢« v v v o ... $ N e R E R S e 108

Resume . ... .......... R T .o .. 109
.

SINGAPOIE « ¢ ¢ ¢ o o 4 v oo 66 6 060 cso sioin s 0o 0e e ¢ wo® I @ 109
.

TAIWAN . . . v e e e e e e e e e e e e e e e e e e S W PR 109

Thailand . . . . . . ¢« ¢ v ¢t i i o v e e e e e e e e e e e e e e e 110

Volunteer . . & v o i i i e e e e e e e e e e e e e e e e e e e 110

7 Copyright LawontheNet .. ......¢.civv v I

Appendix A:CountryCodes . . ... .....cvvvvvveeesa.. 115

Appendix B:ErrorMessages . . ... .v vt vtvnseaaeaaa. 119

Appendix C:Netspeak . ... ... ...t 12l

SIANG ¢ o ¢ o s st v o0 v s s s e e e e " 121
Smileys . ......... e e s e e E e G S E A N e 122
OtherConventions . . . . . . ¢ v i i i v o v e e o v o e oo oo e oo e 123

SelectedBibliography . ... ..... ... . 124

Glossaryof InternetTerms . . . . ... ... v, 128

Index . . ...



CHAPTER

Welcome to the Internet!

€€ The Internet to me is like a library which is five minutes old. People who say
they can find things quicker with a stroll to the local library are missing the
point. The Net is young—one day it will be complete. It’s a vibrant place,
particularly with regard to ESL/EFL teachers and what they are doing. Also
a great place for those of us who need access to ‘pop culture’ information for
our students.”’

Gavin Dudeney
International House, Barcelona, Spain
dudeney@encomix.es

The Internet: What’s in It for Me?

Everyone (and I mean everyone!) seems to be getting onto the Internet on-ramp
these days, but what exactly is this so called “Information Superhighway?” That’s not
an easy question to answer but try visualizing it as a magnificent global network with
millions and millions of computers (and, of course, people) connected to one anoth-
er, where each day people throughout the world exchange an immeasurable amount
of information, electronic mail, news, pictures, resources, and, more importantly,
ideas.

But how does all this help you and your class? Well, imagine an infinite number of
resources available for your students to improve their skills in reading, writing, gram-
mar, listening, pronunciation, vocabulary, idioms, slang, Test of English as a Foreign
Language, and even conversation. Or contemplate your class sharing their creativity
with the entire world—essays, poems, recipes, biographies, or even art work. Or per-
haps communicating—with text, voice, and live video—with ESL/EFL classes from all
parts of the world. Astounding, isn't it?

And what’s in it for you, the teacher? Well, you'll find the Internet to be an exhilarat-
ing tool for meeting and brainstorming with other teachers and students from around
the world, locating and gathering class material, reading the latest journal articles
and publications, accessing language learning software, and even finding a new
teaching job. Sounds wonderful, doesn’t it? It is!
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A Brief History of the Internet

The history of the Internet dates back to 1969, when the Defense Advanced Research
Projects Agency decided to create a way for computers to “talk” to one another over
standard telephone lines. Their network of computers was called DARPANET (soon to
become known as ARPANET), which quickly grew as more and more computers
became a part of this expanding network.

The idea of a network soon became a popular means for scientists and researchers to
communicate and share ideas with one another. In 1984 the National Science
Foundation started the NSFNET network, which linked five supercomputer centers.
Universities were then able to easily enter this network by accessing one of the five
supercomputer centers.

NSFNET grew rapidly, as every school and government agency wanted to become
part of this exciting international network. As more and more computers became
interconnected, NSFNET became known as the Inter-Net-Network, otherwise known
as the Internet. Today there are millions of computers from nearly every country in
the world connected to the Internet, and many more millions of Internet users.

Internet 101: The Basics

A lot of people think that the Internet is just a single entity, but the truth is that the
Internet is made up of a combination of various software applications, each with their
own unique function. Once on the Net (as the Internet is often called), you'll be able
to enjoy such goodies as:

B E-mail — Electronic mail allows you to instantly send and receive messages from
around the world.

B World Wide Web — With its colorful mix of hyperlinks, text, graphics, images,
sound, and video, the Web is where it’s at!

B Gopher — Another way of exploring the Internet to find information.

B File Transfer Protocol (FTP) — A way to transfer files from one computer to anoth-
er computer over the Internet.

B Telnet — An application that enables you to log in to another computer system
on the Internet.

B USENET Newsgroups — A network of more than 20,000 discussion groups on
thousands of specialized topics.

B Chat — A way tc communicate in real time with other users whereby those users
type simultaneously.

B Audio — Communicating as with a telephone over the Internet.
B Videoconferencing — Voice and video communication.

B And More!
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Getting Connected

Now that I've got you all excited about what the Internet’s all about, let’s learn a little
bit about how to get you and your class up and running. Here’s what you need:

e A computer Of course you'll need a computer in order to hook up to the Net, and
almost any one will do. However, in order to take advantage of the latest and
greatest Internet software (like Netscape Navigator for exploring the Web), you'll
need a late-model Macintosh or a PC running Microsoft Windows or Windows 95.
Lots of memory (RAM) helps, too.

e Amodem It’s the modem that enables your computer to transfer data over the
phone lines and therefore connect you to the Internet. Modems come in various
speeds measured in bps, or bits per second. Do yourself a favor, however, and buy
the fastest modem possible (I suggest 28,800 or 33,600 bps) because it will make
your journey a lot more pleasant.

Types of Connections

Dial-up Accounts

Now that your computer and modem are set up, you'll need an Internet connection.
The most common type is through a Dial-up account, where you dial into your
Internet account through your modem. There are three types of dial-up accounts:

1. Terminal Connection Also called a shell account, this is the most basic type of
Internet access, giving you a text-only environment with little or no graphics
(images and pictures). Use only as a last resort!

2.SLIP/PPP Connection Slip (Serial Line Interface Protocol) and PPP (Point-to-
Point Protocol) are quickly becoming the most common way for people at home to
access the Internet. This type of connection enables you to directly connect to the
Internet via an Internet Service Provider (ISP), enabling you to use the newest and
best graphical Internet software.

Tip: For the world’s most comprehensive and up-to-date listing of Interet Service Providers,
surf over to The List (http://thelist.iworld.com/), where you can search a data-
base of thousands of ISPs from around the world.

3. Commercial Online Access Millions of users have Internet access through large
commercial online companies, which usually simplify the process of installing and
configuring Internet software, as well as provide access to their own services and
forums. Remember, however, that you might be limited to using only their Internet
software (which is not always good), and the cost is also often more expensive than
local or national Internet Service Providers. You'll find that it pays to shop around.
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The four online giants are:

America Online Prodigy

(800) 827-6364 (800) 776-3449
(http://www.aol.com/) (http://www.prodigy.com/)
$19.95 a month for unlimited access. $19.95 a month for unlimited access.
CompuServe Microsoft Network (MSN)

(800) 848-8199 (800) 386-5550
(http://www.compuserve.com/) (http://www.msn.com)

$9.95 a month for 5 hours, $2.95 for $19.95 a month for unlimited access.

each additional hour; $24.95 a month
for 20 hours, $1.95 for each additional
hour.

Dedicated Connections

Most colleges, universities, and schools offer a high-speed dedicated connection,
where the computers on campus are permanently connected to the Internet. This
type of connection is fast, doesn’t require a modem to dial, and is always linked to the
Internet, 24 hours a day.

A Peek into the Future

There’s no doubt that the Internet will become increasingly faster, with graphics,
sound, and video images instantly flashing across the screen. ISDN (Integrated
Services Digital Network) is already available in many places, and offers a high-speed
digital telephone connection to the Internet, with speeds of 56,000 to 128,000 bps
(and that's fast!). At this time, however, ISDN is still expensive in many areas, so call
your local telephone company for more information.

Also keep an eye out for satellite connections, with speeds hovering around 182,000
bps, and cable modems,with lightning speeds starting at a whopping 500,000 bps!

The World Wide Web

The World Wide Web (also called WWW, or the Web), is fast becoming the most pop-
ular area of the Internet. With its mix of text and multimedia—and user-friendliness
thrown in—the Web is a magnificent collection of interconnected documents (called
Web pages) from around the globe.
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The Web began in Switzerland at CERN (The European Laboratory for Particle
Physics), where scientists developed hypertext, an easier method of navigating the
Internet, where text is used to link documents. With hypertext, a simple click of the
mouse enables you to easily jump around the world: to read the latest news in The
New York Times, search for teaching material in Australia, chat with friends in South
Africa, view paintings from art galleries in Paris, listen to pop music from Korea,
download the newest software in California, and even participate in live videoconfer-
encing with an ESL/EFL class in another country.

Web Browsers

To access the Web, you'll need a Web browser, which is the software through which you
navigate the World Wide Web. There are lots of Web browsers on the market, but the two
most popular are Netscape Navigator and Microsoft Explorer.

Netscape Navigator
(http://home.netscape.com/)
My personal favorite, it’s powerful, easy
to use, and performs equally well on
the Mac, Windows, and UNIX.

El=—————————— Netscape: Welcome toNetscape =F——————————

ﬁ"“"& RiB|lZ| S| A

Foriward| Home Reload | Images | Open | Print Find

Netsite: [Mip 4 /veww netscape .com/

[hat’s New? | [ Whats Coo1? | | Destinations | [ MetSearch |[ People || Software |
"M‘ WELCOME TO
NETSCAPE
d . b A

&9 5
YOUR CGUIDE YO NAVIGATING THE X NET & &

| oNE stop
| SOFTWARE

ASSISTANCE

NETSCAPE COMPANY & INTRANET DEVEDGE GENERAL
DESTINATIONS | PRODUCTS SOLUTIONS ONLINE STORE

NETSCAPE POSTS INCREASED Q4 REVENUE

33| Document : Done.
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Microsoft Explorer
(http://microsoft.com/)

Also very easy to use. It does have an
advantage, however, over most of the
competition: all versions are free.

= Netscape: lJelcome To Micresoft =&————— @1
lew:a_xgj Home | Reload | images | Open | Print | Find |  sStop | G L ’
Looltion h“p://mierosoft,corﬁ/ ‘ .

‘What’s New? | What'sCool? | Handbook | NetSearch | MetDirectory| Software |

M microsory PRODUCTS SEARCH SUPPORT sHop WRITE US Microsoft

Wh?rjdo you want o
=W, ‘Microsoft

B Microsoft Office 97 Is Here!

| ErJ=)] Reading file...Done T ()

Check this out: No access to a computer? You can now surf the World Wide Web right from
your television with WebTV from Philips Magnavox. This ingenious little device plugs into the
back of your television set and offers foolproof access to the World Wide Web and
e-mail (http://www.magnavox.com/hottechnology/webtv/webtv.html).

If you only have access to a basic shell account, give Lynx a try (http://
kufacts.cc.ukans.edu/lynx_help/lynx_help main.html). Itsa text-only
Web browser, but it’s fast and fairly easy to use. And, if you are using Windows, you can
supplement it with SlipKnot (http://plaza.interport.net/slipknot/
slipknot.html), which magically allows you to view graphics while using Lynx.

Tip: If you have access only to a text-only terminal connection, don’t despair; TIA has
arrived! The Internet Adapter is a program that emulates a SLIP/PPP connection, providing
access to all the fun and exciting Internet software (http://marketplace.com/).
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The Web Address

Accessing another Web site is as easy as a click of your mouse. However, there m~y be
times when you will need to manually enter a URL, or Uniform Resource Locator
(pronounced U-R-L). Here, for example, is the URL, or Web address, to my home
page, The ESL Cafe:

http://www.eslcafe.com

http stands for Hypertext Transfer Protocol and is necessary for connecting to Web
pages across the globe.

:// comes next and is an essential part of the address.

Finally comes the site where the Web page is actually located, as in
www.eslcafe.com

Tip: If you're not able to connect to a site and you believe that the address might be wrong,
don’t give up. Try connecting to the site again. Once connected, enter the remaining direc-
tory names one by one until you find a link to the correct URL.

Some Cool Tips

e It's easy to lose track of where you've been while surfing the Web, so make sure
that you create bookmarks (or “favorites” with Microsoft Explorer). This will
enable you to effortlessly return to your favorite sites on future visits.

e When you get tired of waiting for a page to load, try pressing the Stop button.
¢ Take advantage of the Back and Forward buttons for easier navigation.

e With Netscape and Explorer, you don’'t need the http: // when manually enter-
ing a URL. For example, just typing www.eslcafe.com gets you to my home

page.
* You can have more than one browser open at the same time. For Netscape,

choose New Browser from the File menu. On Explorer, choose New Window from
the File menu.

¢ Looking for some particular text on a Web page? Go to the Edit menu and choose
Find. If it’s there, you'll find it



